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Start working 
with text

Module 3.1

What is a word processor?
A word processor is a computer program designed to create documents that contain 
mainly text. This includes letters, reports, fax cover pages, brochures, minutes, 
advertisements and agendas.

The appearance of a document is just as important as its content. Word processors 
have a variety of facilities that can be used to round a document off professionally.

What is a word 
processor?
Meet the working 
environment
How to work with files  

Create and save
Viewing a document 
Printing a document

Creating a document  
Entering text 
Inserting symbols
Hidden formatting 
symbols

Character formatting
Character type or font
Character styles  
Character sizes

Work carefully through the 
modules and activities and 
observe all the tips and 
notes. It is a big advantage 
to be good at Word, and to 
be able to work quickly and 
effectively in it.
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Meet the working environment
When you load or open Word, the word processing window is presented as a blank 
‘page’ on which you can start to type. 

At the top of the window you will find Word’s Ribbon. The Ribbon contains all the 
facilities of Word organised into a number of tabs. Each tab in turn contains groups 
with related commands. 

The Home tab, for example, contains the most commonly used commands.

How to work with files 
Computer files are used to store everything we wish to save on a computer.

The File tab at the left of the Ribbon opens a drop-down menu that contains file-
related commands, which can be used to open and save files, and to print out 
your work.

For the tasks that 
follow we are going 
to start by opening 
this menu. (You 
can also press 
<Alt><F> to open 
it.)

The Quick Access Toolbar is 
normally above the Ribbon and 
contains frequently used commands 
(like saving your work). 

The Quick Access Toolbar can be 
customised. Click on the small arrow 
at the right, and select which objects 
should appear on the toolbar.
You can also right-click on a command 
on the Ribbon and select ‘Add to Quick 
Access Toolbar’.

The name of a tab 
describes what sort of 
commands it contains. 
Also, the commands are 
organised in groups. You 
must just think carefully 
when looking for a 
command.
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Create and save
Opening a new blank document

When Word is loaded, a blank document in which you can type will usually appear. 
If you need to create a new document, proceed as follows:

	File, New, Blank document. 

A new document is created in the 
computer’s memory (RAM). Note that 
this document is NOT automatically 
stored on the disk.

The file is saved in the 
location you selected 
under the given file name. 
A copy now exists in the 
memory as well as on 
disk.

The copy in memory (with 
any changes you made) is 
written to the disk. 
The existing copy on disk is 
overwritten. 

The copy in memory (with 
any changes you made) 
is written to disk. 

Saving a new document for the first time
	File, Save or Save As. 
	Select the location where you want to save the document (drive and folder).
	Type the name of the document in the File name box.
	Save.

Saving an existing document under the same name and in the same 
location 
	File, Save. 

Saving an existing document under a different name or in a different 
location
	File, Save or Save As. 
	Select the location where you want to save the document (drive and folder).
	Type the name of the document in the File name box.
	Save.

Note that there will now be two copies of the document on disk, one in the original 
location and one in the new location. The latest version of the document will always be in 
the new location.

All work (data) in memory 
will be lost if you shut down 
your computer (or close the 
application) without saving 
the work to storage, so 
SAVE OFTEN!
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Viewing a document
When we create a new document, it displays 
automatically in Print Layout (as it will be printed).

On the View tab there are various display options 
including options that allow you to increase or 
decrease the viewing size of the document.

Printing a document
To print a document:
	File, Print.
	 (A print dialog box or pane will appear.)
	 Here you can indicate, among other printing 

options, which pages must be printed, as well as 
how many copies.

	Select the desired options.

	Click on Print.

Opening an existing document
	File, Open.
	A list of recently opened documents appears. 
	Click on the correct file name. 
	 OR

First locate the file that you wish to open.
	 It may be necessary to use a different location (Word 2016 ‘Browse’ / Word 

2013 ‘Computer’).
	 Select the place where the document was saved (drive / folder). 
	 Click on the correct file name.

To store these changes permanently you must Save the document.

A copy of the document is loaded into memory, and 
any changes to the document are made only in 
memory. 

Important!
Look at the preview of the document to check the 
layout of the document before you print!
Only print the document once you are completely 
satisfied with the layout, spelling, etc.
This saves paper, ink, time and money!

Think before you ink! Is it 
really necessary to print that 
document? Work with soft 
copy wherever possible: 
it takes less space and 
you save ink, paper and 
electricity!
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Creating a document 
To create a new document, start simply by typing on the blank page that appears 
when Word is opened. File, New can also be used to begin a new document.

Entering text
The Enter key should only be used at the end of a paragraph. You should therefore 
continue typing when you come to the end of a line. The words will automatically 
move down to the next line as needed. This feature is called word wrap. When you 
do press <Enter> to begin a new paragraph, Word will automatically leave a little 
extra space between the new paragraph and the previous one. 

There must always only be one space between adjacent words. There must not 
be a space in front of a punctuation symbol such as a comma or a full stop. After a 
punctuation symbol, however, there must always be a space.

1 Activity

Create a new document and type the following into it:

“When you type in a word processor, you should simply continue typing. You will see 
that, when you reach the edge of the page, the words 
wrap to the next line by themselves. Press the Enter key 
only when you reach the end of the paragraph. 

Always leave only one space between words. There must 
NOT be a space just before a punctuation symbol like a 
comma or a full stop. Leave just ONE space AFTER a full 
stop (before you start a new sentence).

Fortunately you can erase mistakes. Use the Backspace 
key to remove characters to the left of the cursor, and the 
Delete key to remove characters to the right of the cursor.” 

Save the document as First.

Try the following: Hold 
down the Ctrl key 
and roll the mouse 
wheel forwards and 
backwards. You will 
see this is an easy 
way to zoom in and 
out.
You can also use the 
relevant options on the 
View tab. 

The Undo command is very useful if you want to undo / reverse an action. 
The easiest way to do this is simply to press <Ctrl><Z>. The Redo command 
(<Ctrl><Y>) cancels the Undo command. 

You can also use the icons on the Quick Access Toolbar. 

Inserting symbols
Over and above the normal characters on the keyboard, there 
are all sorts of symbols that can be added to a document.

Add other symbols to your document as follows:

	Click on the Insert tab and then on Symbol in the Symbols group.
	Click on More Symbols… and select the Font that you want to use.
	Click on the desired symbol.
	Insert, Close.

Get this right from the 
start!

When you create a 
document save it 
immediately (even if it is 
empty). It is also a good 
idea to save a file under 
a different name before 
making big changes, so 
that you can go back to the 
original if you don’t like the 
changes!

<Ctrl><Z> is a life-saver!
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2 Activity

Select (normal text) or the same font as 
that of the surrounding text.

The Wingdings (and Webdings) 
font types have a number of 
interesting symbols that can be 
included in documents.

Hidden formatting symbols
Every character that you type is stored as a particular ‘code’ on the computer. Even 
if you press the space bar, the code for a space is registered!

The hidden formatting symbols will be displayed when you click on ¶ in the 
Paragraph group. It is sometimes useful, as you can then see where you used the 
Space Bar, Enter or Tab keys.

1.	 Open the document Diacritics. It already contains two paragraphs. Add the 
examples, as shown below, and save it again.

The Tab key can be used 
to align sections of text 
neatly below each other. 
Never use the space bar 
for this purpose.

2.  Open the document Symbols. Follow the instructions given in the document. 

Often we need characters 
like ‘é’ and ‘ë’. It is much 
easier to learn their 
codes and to use only the 
keyboard to insert them.

Hold down the Alt key.

Type the character code for 
the symbol on the numeric 
keypad (make sure Num 
Lock is on): for example, 
130 for é, and 137 for ë. 

Release the Alt key. 
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Character formatting is the 
altering of the appearance of 
characters/text. In other words, 
it is the manner in which it is 
displayed in terms of font type, 
size, colour, etc.

Examples of fonts 

 

Character formatting
We can make the content of our documents 
appear differently. This is called formatting. Word 
contains instructions that can be used to format 
any element in a document. We begin by looking 
at the formatting of ordinary characters or text.

Character type or font 
The word font refers to the design of characters which is constant across a set of 
letters, numbers and symbols. Take a look at the example.

There are many font types to choose from. Calibri 
is the default font for Microsoft Word 2016. This 
means that the font of any new document will be 
Calibri, unless you change it.  

Fonts are classed into two main categories:

•	 Serif fonts
•	 Sans Serif fonts

Tab

Spaces

Enter

Simply click on Show/Hide ¶ once 
more to hide these characters from 
view.

Open the document GrassGreener and fix all the spacing mistakes.  

Click on ¶.

3 Activity
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Character styles 
Different character styles are used to 
emphasise certain words. 

Character sizes
The size of text is measured in points (pt). 
The best size to use in A4 size documents is usually 10–12 pt. 

Changing character type (font), size and style using the Font group: 

	Select the text that you wish to change.
	Choose the font type / font size / font style(s). 

The Cambria font type 
has short, decorative 
lines (serifs) at the 
beginnings and ends of 
the strokes that make 
up each character. It is 
therefore a Serif font. 

The Calibri font type is 
a simpler character type 
without any short lines at the 
beginnings and ends of the 
characters. We call this a Sans 
Serif font. (The French word 
sans means ‘without’.) 

Normal text
Bold
Italic
Underline
Bold and Italic and Underline

Character type
Character size

Character style

Ways in which to select text with the mouse

•	 Place the cursor at the beginning of the text that must be selected. Hold 
down the left mouse button and drag the cursor to the end of the text.

•	 A single word can quickly be selected by double-clicking on it.
•	 Click in the white space at the left if you wish to select a line of text. The 

cursor will change to an open white arrow. 
•	 A paragraph can be selected by a triple-clicking in it. 
•	 You can even select a number of non-adjacent sections of text by holding 

down the Ctrl key while selecting each one in turn.

The basic character formatting options as 
well as other options are available if you 
open the dialog box of the Font group. 
Remember first to select the text that you 
wish to format. 

Go easy on character 
styles (and be consistent 
in using them). Too much 
bold / italics / underline in 
text loses its impact and 
it looks untidy.
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1.	 Open the document Speed. Complete the formatting 
instructions as requested in the document.

2.	 Open the document Cyberkid. Format the document 
as described below, but for bold and italic you may use 
only the keyboard shortcuts <Ctrl><B> and <Ctrl><I>.

•	 The heading must be bold and have a font size 
larger than the rest of the text.

•	 The paragraph in bold must be changed to regular 
text.

•	 The two sub-headings (each begins with ‘In the 21st century’) must be bold.

•	 The ‘st’ of 21st must be superscript. 

•	 All the words and abbreviations typed in uppercase, must be bold.

•	 All the words in upper case that are not abbreviations (e.g. WORK) must be 
changed to lower case, and bold.

•	 All the dialogue (sentences in quotation marks) must be italic.

•	 All shading must be removed.

•	 The font size of the last sentence must be reduced, but still be larger than 
the rest of the text, and changed to small caps. The italics must also be 
changed to regular text.

3.	 Open the document Diary4March. Use the Font dialog box and Effects, Hidden 
in order to hide all the text between the two dates. (You can unhide it again by 
selecting this part of the document and using the Font dialog box once more.) 

	 Can you think of any other way of ‘hiding’ text? Do this with the heading 
LOCNVILLE DIARY at the top of the document.

When you rest the 
mouse on certain 
commands in the Font 
group, the keyboard 
shortcut is displayed 
in a tooltip for that 
command.

Tips for font choice 

With all the different fonts available, it is easy to overdo things when it comes to 
the choice of fonts. Bear the following in mind:

•	 A document looks best if you use a maximum of 2 or 3 font types. Limit the 
use of many different fonts in your document. Rather use size variations and 
different styles, such as bold and italic, for emphasis. 

•	 Ensure that the font you choose matches the purpose of the document. 

		 Courier New looks old fashioned and would be 
inappropriate for an advert for your school fete. It 
would be better suited to an article on the Second World 
War, for example. 

	 Bradley Hand ITC would be appropriate for a party invitation. 

•	 For long pieces of text rather use simple fonts (e.g. Arial, Calibri, Verdana) 
because they are more legible.

 	 (Decorative fonts can be used for headings but not for long pieces of text.)

4 Activity
Repeat Activity 4.1 so 
as to practise selecting 
text quickly and using the 
keyboard shortcuts for 
bold and underline. Save 
the document Speed as 
Speed1 and Speed2.
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It is very important that information should be easy to read and understand, and that the 
font type used should be suitable for the type of document.

Open each of the following documents: Invoice, Testimonial and Menu. 

Change the font type and size of the documents to improve legibility. Make sure that the 
font type is suitable for the document. 

5 Activity

Save Make a permanent copy of a document on disk.

Save As Similar to Save, but you can specify the file name and location of the saved 
document.

Word wrap Text flows automatically from one line to the next in a paragraph as you type. 
(Only press <Enter> at the end of the paragraph.)

Spacing 
conventions

•	 One space between adjacent words

•	 One space after a punctuation symbol

•	 No space before a punctuation symbol

Selecting text •	 First select the text that you wish to format

•	 Mouse shortcuts: double-click, triple-click, click in margin

•	 Keyboard shortcuts: Shift + cursor keys   

•	 Non-adjacent sections of text: use Ctrl key

Font choice •	 Use a maximum of 2 or 3 font types in a document

•	 Choose a font that suits the type of document

•	 For long pieces of text use simple fonts (e.g. Calibri)

•	 Reserve decorative fonts for headings etc.

•	 Use font sizes of 10–12 pt for for the body text in ordinary documents.

•	 Do not type long sections of text in uppercase 

Keyboard 
shortcuts

•	 <Ctrl><S>	 Save

•	 <Ctrl><B>	 Bold

•	 <Ctrl><I>	 Italics

•	 <Ctrl><U>	 Underline

•	 <Ctrl><A>	 Select all

•	 <Ctrl><Z>	 Undo

•	 <Ctrl><Y>	 Redo

•	 <Alt><F>	 Open the File tab

Summary – concepts, terms and tips

Test and improve 
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Written module activity

Practical module activity

1.	 Why should you ‘preview’ a document before you print it?

2.	 Give two situations in which you would use the Save as option rather than the Save option 
when saving a Word document.

3.	 Explain the correct use of the Enter key in typing a document.

4.	 Someone sent you a long document with all the text typed in uppercase. What is the quickest 
way to correct this?

5.	 What font sizes are generally suitable for ordinary text in an A4 document?

6.	 Name two keyboard shortcuts that you often use, and state what each is used for.

7.	 Examine the extract below and describe the spacing and formatting errors that have been 
made. In each case give the correct spacing / formatting procedure. 

1.	 Open the document HerbGarden.
	 Correct all the errors that you identified in Written module activity No. 7.

2.	 Open the document Hectic_Day and do the following: 

•	 Change the text to have a more suitable font size.

•	 Make the font of the heading Cambria 14 pt, bold.

•	 Correct the spacing errors in the first paragraph.

•	 Combine the two paragraphs of text in blue into a single paragraph.

•	 Change the text in red to Sentence case.

•	 Place the text in green in a paragraph by itself.


